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This policy bulletin is to inform Job Center staff that the latest version 
of the Paperless Office System (POS) migrated to production on 
June 21, 2010. Descriptions of the changes can be found in POS 
Release Notes Version 14.2 (Attachment A), Desk Guide-
Introduction to POS Portal: Appendix A (Attachment B), and ACCIS 
Clearances: Appendix B (Attachment C). 

  
 These release notes can also be found on the HRA Intranet at:  
  
 http://hrawebapps/HRAintranet/CMT_page_template.cfm?page_id=79

 
  
 Effective Immediately 
  
 Related Item: 
  
 PD #01-49-EMP
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POS Release Notes 
Version 14.2 June 21, 2010   

Attachment A 

These Release Notes contain descriptions of changes in POS Release 14.2 scheduled for June 21, 2010. 
These have been distributed via HRA email.  If you would like to be added to the distribution list, please 
contact Sandra Hilton.  These and prior Release Notes may also be found on the HRA Intranet at 
http://hrawebapps/HRAintranet/CMT_page_template.cfm?page_id=79 
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1. New POS Web Portal 
 
A new POS Web Portal will allow staff to easily access the POS sign-on, POS web-based tools, Front 
Door Reception (FRED), other related systems and system documentation. 
 

 
 
For additional details, please see the Appendix A: POS Web Portal. 
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2. Active Child Provider Matches in ACCIS 
 

POS will now identify applying or active individuals who are also identified as child care providers 
receiving payment via the Automated Child Care Information System (ACCIS). POS will launch an 
automated lookup to ACCIS using the applicant/participant social security number at the time of 
application and recertification.  
 
If matches are found, a new ACCIS Clearances window will appear for each individual for whom a 
match was found in the CA Application Interview, EC – CA Application Interview, CA 
Recertification Interview and EC – CA Recertification Interview activities after the Worker clicks the 
Next button in the Absent/LRR window.  
 
ACCIS Clearance Window 
 

 
 
For additional information, please see the Appendix B: ACCIS Clearances. 
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3. Printing of Immediate Need Grants from IN/EFS Issuance Activity 
 
Immediate Need grants (Cash Assistance grant code 44) prepared in the IN/EFS Issuance and EC – 
IN/EFS Issuance activities has been sent to the Single Issue Printing Queue when the supervisor 
completes the Approve IN/EFS or Approve EC – IN/EFS activity. 
 

4. Updates to Match WMS Version 2010.2 
 

The following changes have been  made to match the updates in the Welfare Management System 
(WMS) version 2010.1, which will be released on June 21, 2010: 
 
 WMS will no longer require an entry in the AD-EX field when the employment code is 43 

Incapacitated - SSI Application Filed. 
 The Cash Assistance (CA) Basic Allowance will increase by 10% effective July 1, 2010. 
 New income source code 76 (Youth Build) 
 New individual closing codes P44, P45 and P46. 

 
New Income Source Code 76 (Youth Build) 
 
A new Income Source Code 76 has been added to the other income window identifying income from 
Youth Build (a federal training and work program) for young people between the ages of 16 and 24. 
 
Youth Build income will be counted as Earned Income for CA and Exempt Income for FS and will be for 
cases with budget effective dates of 05/A/10 or later.  
 
Income from Youth Build is exempt for FA cases, but counted for SNA cases except for those with 
dependent children under 21 and who are full or part-time students. Youth Build income would be 
exempt for these students, our standard student income exemption. Workers would review on a case-
by case basis whether to enter this income into the system.  
 
Youth Build income is exempt for MA. 
  
New Individual Closing Codes  
The following Cash Assistance (CA) individual closing codes will be added: 
 
 P44-Failure to Comply with Drug and/or Alcohol Assessment 
 P45-Failure to Comply with Drug/Alcohol Assessment 
 P46-Failure to Comply w/ D/A Release Info 

 
Policy 
For additional information on the WMS system updates please refer to the Policy Directive. 
 

5. Self-Employment Window Update 
 

The Business Type text box in the Self-Employment window will be converted into a drop-down menu 
with the following options: 
 
 Accounting 
 Cosmetic Sales 
 Bait business 
 Bakery 
 Business Owner or Operator 
 Carpentry or Construction 
 Crafts 
 Clamming 
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 Corporation 
 Car repair or restoration 
 Computer service 
 Catering 
 Contract work 
 Cycle shop 
 Electrician 
 Farming 
 Fishing 
 Gambling 
 Housekeeping 
 Hunting 
 Insurance Agent 
 Junking 
 Kennels 
 Lawn care 
 Logging 
 Manufacturing 
 Musician 
 Odd jobs 
 Other 
 Painting 
 Newspaper delivery 
 Photography 
 Plumbing 
 Partnership 
 Real estate agent 
 Sawmill 
 Selling blood 
 Selling produce 
 Sewing 
 Tavern 
 Truck driving 
 Tattoo parlor 
 Trapping 
 Tax preparation 

 
Self-Employment Window 
 

 
 

Page 5 of 11 



POS Release Notes 
Version 14.2 June 21, 2010   

Attachment A 

6. Saving Data for Individuals with the Same Name 
 
When two individuals with the same name appear in a response window, the data is occasionally saved 
under the wrong individual’s name. The response windows will be updated to resolve this type of error. 
 

7. Model Office Updates 
 
The following configuration updates were made in the Model Office systems (FRED and MONIQ) in 
April, May and June 2010: 
 
 The Special Assessment, HEAP and OEM queues at the Richmond Job Center (099) were 

disabled; 
 The CA Info Verification queue was activated at every CA model center, including the Family 

Services Call Center satellites.  Three NYCWAY appt codes are mapped to it: 10DC, 10DR and 
10DT; 

 The Concourse Job Center (045) was closed.  However, Management Console users will be able to 
generate Model Office Time Reports for a few weeks.  The other MO reports won't be affected by 
the closure; 

 The Concourse FS Center (F45) opened on April 26, 2010 as a Model Center;  
 Double-clicking on the “Route to Selected Appt” button will only print one ticket; and 
 The CA Appl Interview queue has been disabled in FRED. 

 
8. E-Forms 

 
The following E-Form have been updated: 
 
 W-515X, SAVE Referral 

 
The following E-Form will be added to POS: 
 
 W-274U, Attestation of Employment as a Childcare Provider 

 
9. Reminder: Appendices 

 
 Appendix A, POS Web Portal 
 Appendix B, ACCIS Matches 
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10. Single Issue Printing Queue Enhancement for HASA Fair Hearing Staff 
 
A new filter has been added to the top of the Single Issue Printing Queue window for HASA Fair 
Hearing staff enrolled at the Waverly HRA Center (013). This filter will allow the HASA Fair Hearing 
staff to print the grant forms that they prepare for the following centers: 
 
 013 Waverly HRA Center 
 019 Crotona HRA Center 
 024 Amsterdam HRA Center 
 041 Grand Concourse HRA Center 
 043 Kingsbridge HRA Center 
 048 Jerome HRA Center 
 051 Queensboro HRA Center 
 063 Coney Island HRA Center 
 072 Hamilton HRA Center 
 073 Brownsville HRA Center 
 085 Greenwood HRA Center 
 099 Richmond HRA Center 

 
Grant forms prepared by HASA Fair Hearing staff will not appear in the regular HRA center Single Issue 
Printing Queues. 
 
Revised Print Queue for HASA Fair Hearing Staff 
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11. Single Issue Reminders: Entry of Approved Amount in SI Task 6 
 
For accepted requests, the Worker must enter the approved amount in the Referrals and Outcomes 
tab in SI Task 6 in order to ensure that the proper amount pre-fills the grant data entry windows, 
repayment agreement forms and applicant/participant notices. 
 

12. Single Issue Reminders: Proper Processing of Repayment Agreements 
 
To correctly process the repayment agreements for utility arrears, fuel arrears and rent arrears, 
the worker must fully complete the Request Action window in the Outstanding Requests (SI Task 6). 
 
Utility Arrears and Fuel Arrears (Grants Tab) 
 

 
 
When a utility arrears or fuel arrears request is accepted for a grant, the Worker must select “Yes” in 
the Payment Recommended field in the Utility Liaison Recommendation. 
 

 
 
The Worker must fully complete the Utility Liaison recommendation section, particularly the payment 
amount and dates. This will ensure the proper processing of the repayment agreement, when it is 
required. 
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The recommended payment will transfer to the Utility Arrears Repayment Agreement (W147X). If the 
worker does not enter the payment amount, it will not transfer to the Repayment Agreement 
correctly.  
 
The worker must proceed to process the additional tabs to complete the Task 6, Request Action 
window. 
 
Rent Arrears (Referral and Outcomes Tab) 
 

 
 
When a request for back rent or back mortgage is accepted for a grant, the Worker must fully complete 
the Referrals and Outcome tab. In the Referrals and Recommendation Received sections, the 
Worker must fill in the required information. 
 
The Worker must click Yes for the Referral to field.  This will enable the Recommendation Received 
section. 
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The Worker must select Issue Grant or Issue Grant Conditionally in the Recommendation Received 
section. The Worker must then enter the Approved Amount and Approved Period. This will ensure 
the proper processing of the repayment agreement, when it is required. 
 

 
 
The approved amount will transfer to the Emergency Assistance to Needy Families Agreement to 
Repay Excess Shelter Arrears (W-147KK) or the Emergency Safety Net Assistance Shelter Arrears 
Repayment Agreement (W-147H).  
 
If the Worker does not enter the approved amount, it will not transfer to the Repayment Agreement 
correctly. The Worker must proceed to process the additional tabs to complete the Request Action 
window. 
 

13. Single Issue Reminders: Re-Printing Grant Forms 
 

Once the Print Grant Forms row is completed in the Single Issue Printing Queue, the form cannot be 
printed from this queue. 
 
To reprint SI grant forms that were printed using the Single Issue Printing Queue, the worker must 
access the Review Case activity, click the Next button in the Activities window, select Tools and click 
on Printed Forms. The Worker can select the form and click on the Preview button to review the 
form(s) prior to printing. The Re-Print button will allow the Worker to re-print the form(s). 
 
Activities window 
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Tools > Printed Forms Menu 
 

 
 
Printed Forms Window 
 

 
 

14. Single Issue Reminders: Removing Grants Associated with a Grant Request  
 
Occasionally, the Worker may mistakenly mark a grant request as accepted and begin the data entry of 
single issue grants.  
 
To correct the decision and remove grants associated with a grant request that is not ready to receive 
grants, the worker must access SI Task 6 and mark the request as Not Ready in the Grants tab.  
 
If the request will be denied or will be accepted without issuing a grant, the Worker must access SI 
Task 6 and: 
 
 Select a decision of Deny and enter the denial reason; or 
 Select a decision of Accept, select Other Action and enter the action taken on the case.  

 
When these steps are completed, the grants will be deleted from the system. 

Page 11 of 11 



POS Release Notes: Appendix A 
Desk Guide- Introduction to POS Portal 
Version 14.2 June 21, 2010 

 MIS/POS Development & Design Team 1

 
Overview 
 
The Web-Based POS Portal provides a centralized point of access to the Paperless Office System and 
several other applications regularly used by FIA Center staff. The user will have one central location to 
assist them in accessing, reviewing and processing cases.   
 
The POS Portal allows access to the Paperless Office System, POS Management Console and the POS 
release notes. In addition; the POS portal will also provide access to the Non-Cash Assistance Logs  
which includes the Application Log, Recertification Log, and the Deferral Log. It also provides access to 
the NCA FS calendars. The web-based Front Door Reception (FRED) application will also be included in 
the portal.  
 
The POS Portal also provides access to other applications outside of the Paperless Office System. The 
following links are available to the user from the POS Portal Home Page: 
 

 HRA Home Page 
 HRA One Viewer 
 FIA Telephone Recertification Reporting System(IVRS) 
 Food Stamp Employment Tracking System (FSE) 
 Automated Child Care Information System (ACCIS)  
 Public Transportation Automated Reimbursement system (PTAR). 

 
POS Portal Home Page window  
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Definitions  
 
NCA Food Stamp Application Log 
 
The Application Interview Log allows Food Stamp (FS) Centers to assign and reschedule application 
interviews and allows the processing of failed to keep transactions by designated staff. 
 

 
 
NCA Food Stamp Recertification Log 
 
The Recertification Interview Log allows Food Stamp (FS) Centers to view their past, current and future 
Recertification Interview appointments, to assign and reschedule their Recertification Interviews. 
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Food Stamp Deferral Log 
 
The Deferral Log will allow the closing of cases in Single Issue (SI) status that were deferred for 
documentation and failed to return with the requested documentation.  
 

 
 
NCA FS Calendar  
 
The Non Cash Assistance Food Stamps (NCA FS) calendar gives FS Site Managers and Assistant Site 
Managers the ability to create and maintain application appointment slots for designated NCA and 
Community Based Organization (CBO) staff. In addition, FS Site Managers and Assistant Site Managers 
will have the ability to create new calendars as needed.  
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The POS portal also provides external links to other HRA applications that assist the FIA managers and 
workers in maintaining, updating, processing and reviewing cases. 
 
HRA One Viewer 
 
Provides FIA staff with the ability to search and retrieve documents and document-related information.  
 

 
 
Front-Door Reception (FRED) 
 
This Application assists the receptionist at Job Centers/NCA Sites in routing applying individuals and 
those in receipt of benefits to the correct location within the offices.  
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Interactive Voice Response System (IVRS) 

IVRS provides certain NCA FS households with the opportunity to recertify for benefits by use of an 
automated telephone response system. 

 
 
Food Stamp Employment system (FSE) 
 
This system facilitates the management, enrollment and tracking of FS participants who are potentially 
required to participate in work activities.  
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ublic Transportation Automated Reimbursement System (PTAR) 

etro card ordering system for FIA centers. 

 

he POS Portal provides direct links to all of the previous noted applications. The external applications 

ll POS related applications link back to the POS portal which would save time by providing access to all 
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T
outside of POS (HRA OneViewer, ACCIS, and IVRS etc.) will open in their own window allowing the 
worker the ability to access and navigate the application fully.  
 
A
the featured applications. This portal will be updated to include access to other applications as they 
become available in the future.  
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 1

ACCIS Clearances Window 
 
POS will now identify applying or active individuals who are also identified as child care providers 
receiving payment via the Automated Child Care Information System (ACCIS). POS will launch an 
automated lookup to ACCIS using the applicant/participant social security number at the time of 
application and recertification.  
 
• After the Worker clicks the Next button in the Absent/LRR window, if matches are found, a new 

ACCIS Clearances window will appear in the CA Application Interview, EC – CA Application 
Interview, CA Recertification Interview and EC – CA Recertification Interview activities. 

 
If there are communication problems between POS and ACCIS, the following error message will appear: 
 
 “The communication between POS and ACCIS has failed. Please try again later using the tool bar 

option under clearances.” 
 
ACCIS Clearance Window 
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POS Information 
The top section of the window includes the applicant/participant demographics and address information in 
POS. 
 

 
 
ACCIS Information 
The middle section of the window includes the applicant/participant demographics and address 
information in ACCIS. 
 

 
 
ACCIS Net Pay Information 
The lower section of the window provides the net pay information from ACCIS for the last five months (if 
any). 
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Client Match Dispute 
The Worker will need to indicate whether the applicant/participant is disputing the match.  
 

 
 
If an applicant is disputing the match, the following message will appear: “You must make a proper 
referral to the Bureau of Eligibility Verification (BEV)” in the “Referrals” window”.  
 
If a participant is disputing the match, the following message will appear: “You must make a proper 
referral to Bureau of Fraud Investigation (BFI). Select the link in the Help Menu and submit Form BFI-14.” 
 
If the applicant/participant is not disputing the match, the Worker will need to indicate whether s/he claims 
that s/he stopped providing child care.  
 

 
 
If s/he claims that s/he stopped providing child care, the following message will appear:  
 
“You must capture applicant/participant signature.  If the signature pad is not working, you must print the 
form, have the applicant/participant sign it, then scan and index into the OneViewer. You must also, go to 
ACCIS and terminate childcare payments.” 
 
The signature capture for the Attestation of Employment as a Childcare Provider form (W-274U) will 
appear. The Worker must capture the applicant/participant signature using the electronic signature pad or 
must have the applicant/participant sign the manual form and scan and index it into the OneViewer. 
 
Resolution 
The Worker will need to indicate a resolution for the ACCIS match information.  
 

 
 
For applicants, the Worker will need to indicate whether an FIA-3A was initiated and completed. There 
are three options under this menu: 
 
 Yes 
 No 
 Pending 

 
If the answer is No, a comment window will open and the Worker should provide a detailed explanation 
on why the FIA-3A was not initiated and completed. 
For participants, the Worker will need to indicate whether the child care income was previously budgeted 
with the correct amount and whether a recoupment was initiated due to the child care income match. 
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Completion Edit 
If the Worker indicated a resolution of Pending and they attempt to complete the application or 
recertification activity, a completion edit will require answers in the resolution section. The ACCIS 
Clearances window will open and the following error message will appear: 
 
 For applicants: “You must answer the question “Was an FIA-3A initiated and completed” of the 

resolution section of this window” 
 For participants: “You must complete the participant’s questions” of the resolution section of this 

window” 
 

NYCWAY Action Codes 
When a match is found in ACCIS, POS will post the following action code to NYCWAY: 
 
 10DP (Active CC provider review Pool) 

 
When the Worker indicates that a recoupment was initiated due to the child care income match, POS will 
post the following action code to NYCWAY: 
 
 10DB (Active CC provider recoup initiated) 

 
Supervisory Approval 
The ACCIS Clearances window has been added in the following approval activities and will appear when 
ACCIS matches are found: 
 
 Approve CA Eligibility Decision 
 Approve CA Recertification 
 Approve EC – CA Application Interview 
 Approve EC – CA Recertification 

 
The Supervisor will need to approve or disapprove the Worker’s entries in this window. The Approval 
menu will be available under the Window > Approval menu option. 
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Supervisory ACCIS clearance Window 
 
 

 
 
Approval Menu 
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Tools Menu Access to ACCIS Employment Clearances 
In addition, a new option named ACCIS Employment Clearances has been added to the POS Toolbar 
menu under Tools > Clearances to allow the worker to do an ACCIS search at any other POS activity. 
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